Reference

TDS5000 Series
Digital Phosphor Oscilloscopes
071-1020-00
To Use the Front Panel

You can use the dedicated, front-panel knobs and buttons to do the most common operations.

- Turn **INTENSITY** to adjust waveform intensity.
- Push **FastAcq** to turn Fast Acquisition on and off.
- Push **CURSORS** to turn cursors on and off.
- Push **PRINT** to make a hard copy.
- Push **DEFAULT SETUP** to return settings to the factory default values.
- Push **AUTOSET** to automatically set the vertical, horizontal, and trigger controls to produce a usable display.
- Push **OFF** to turn the optional touch screen on and off.
- Push **ZOOM** to add a magnified graticule to the display. Push the **HORIZ** or **VERT** button to select the axis that you want to magnify.
- Use these knobs and buttons to set horizontal **SCALE** and **POSITION** for the waveforms. Push **DELAY** to turn on horizontal delay, and then use **POSITION** to set the delay time. Adjust **RESOLUTION** to change the number of acquired points in the waveform.
- Use these knobs and buttons to set the basic trigger parameters. Push **ADVANCED** to display a menu of additional trigger functions.
- Use these buttons to start and stop acquisition or start a single acquisition sequence. The ARM, READY, and TRIG'D lights show the acquisition status.
- Push **CH< X>** to turn channel displays on and off. Adjust the channel **POSITION** and **SCALE** or change the input termination with dedicated knobs and buttons.

Copyright © Tektronix, Inc. Beaverton, OR 97077
To Use the Screen Interface

You can control all oscilloscope functions, including powering off the instrument, through the screen interface.

Choose the Toolbar

- Click here to change to menu-bar operation.
- Click a button in the toolbar to display a control window at the bottom of the display.
- Click a screen control to change a setting.
- Click a numerical control to assign that control to a multipurpose knob. Turn the multipurpose knob to adjust the parameter value.

Or Choose the Menu Bar

- Use some menu items to display a control window at the bottom or side of the display.
- Use some menu items to directly change settings.
- Click here to change to toolbar operation.
- Click here to close a control window.

More Operating Tips:

- Use the optional touch screen to control the oscilloscope when bench space is unavailable, such as on a cart or in an equipment rack.
- Plug in a mouse and keyboard if you have the bench space to use them. You can plug in a USB mouse or keyboard anytime, even while the oscilloscope is running.
- Use the menu bar to access PC-related functions such as, Page Setup, Export, and Copy.
To Display a Waveform

1. Attach a probe to CH 1 and connect the probe to your signal.

2. Push CH 1 if channel 1 is not already displayed.

3. Push AUTOSET.

4. Adjust VERTICAL and HORIZONTAL POSITION and SCALE if necessary to optimize the display.

5. Adjust RESOLUTION to change the record length and sample rate. You can acquire more samples in the waveform to see more detail, or acquire fewer samples with a faster update rate.

6. Adjust INTENSITY to change the brightness, vector fill, and display persistence of acquired points.

Recommended Probe Accessories

- P5050 Passive Probes for general-purpose applications
- P6243 and P6245 Active Probes or P6158 Low-C Probe for high-speed applications
- P6246, P6247, P6248 Differential Probes for differential signals and low-noise applications
- TCP202 Current Probe for general-purpose applications
To See More Waveform Detail

Use Zoom

Use the Zoom function to magnify an acquisition vertically, horizontally, or in both waveform dimensions. SCALE or POSITION changes you make to the Zoom graticule affect only the display, not the actual waveform that is acquired.

1. Push the ZOOM button to split the screen and add a zoom graticule.

2. Push the HORIZ button or the VERT button to select the axis you want to magnify in the zoom graticule. Use the multipurpose knobs to adjust scale and position of the magnified waveform.

3. You can also set up a zoom graticule from the screen interface. Click and drag across the segment of the waveform that you want to see in greater detail.

4. Then select Zoom from the drop-down list to magnify the highlighted waveform segment.

Use Horizontal Delay

Use horizontal DELAY to acquire waveform detail in a region that is separated from the trigger location by a significant interval of time.

1. Push the front-panel DELAY button.

2. Adjust the delay time with the horizontal POSITION control, or enter the delay time in the control window.

3. Adjust the horizontal SCALE to acquire the detail you need around the delay expansion point.

More Operating Tips:

- You can use Zoom and Horizontal Delay together to magnify a delayed acquisition.

- Toggle Horizontal Delay on and off to quickly compare signal details at two different areas of interest, one near the trigger location and the other centered at the delay time.
To Use Fast Acquisition

Turn Fast Acquisition on to acquire up to 100,000 waveforms per second.

1. Push the front-panel FastAcq button.
   Or select Fast Acquisitions in the Horiz/Acq menu.

2. Adjust INTENSITY to optimize the intensity or color grading for the signal you want to analyze. Increasing intensity can make less-frequently acquired points brighter in the display.

How DPOs Work

Unlike DSOs that have long dead times between acquisitions, Digital Phosphor Oscilloscopes (DPOs) continuously acquire waveforms at rates comparable to analog oscilloscopes. DPOs continuously overlay the acquired information into a three-dimensional database that is updated on the display 30 times per second. For each pixel in the display, the intensity (or color) of the pixel is proportional to the number of actual samples that the pixel represents.

More Operating Tips:

- Choose one of the color grading palettes in the Display Colors control window to see different sample densities represented in different colors.
- Turn AutoBright on in the Display Appearance control window. When you use AutoBright, the displayed waveforms remain visible even at low trigger repetition rates.
To Choose an Acquisition Mode

1. Select Acquisition Mode... in the Horiz/Acq menu.
   Or click the Horiz button, and then select an acquisition mode in the horizontal/acquisition control window.

2. For Average or Envelope acquisition modes, click the # of Wfms control and then set the number of waveforms with the multipurpose knob. You can also double-click the control and use the pop-up keypad.

How the Acquisition Modes Work

- **Sample** mode retains one sampled point from each acquisition interval.

- **Peak Detect** mode uses the highest and lowest of all the samples contained in two consecutive acquisition intervals.

- **Hi Res** mode calculates the average of all the samples for each acquisition interval.

- **Envelope** mode finds highest and lowest record points over many acquisitions. Envelope uses Peak Detect for each individual acquisition.

- **Average** mode calculates the average value for each record point over many acquisitions. Average uses Sample mode for each individual acquisition.

Displayed record points (at maximum horizontal magnification)
To Select a Trigger

Select the **EDGE** trigger type and then set the source, coupling, slope and mode with these front-panel controls. Push **ADVANCED** to select one of the other trigger types.

You can also select a trigger type in the **Trigger** menu.

Or click the **Trig** button and then select a trigger type in the trigger control window that is displayed.
### Trigger Selections

<table>
<thead>
<tr>
<th>Trigger type</th>
<th>Levels</th>
<th>Timers</th>
<th>Trigger conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge</td>
<td>Single level</td>
<td>None</td>
<td>Trigger on rising or falling edge, as defined by slope control. Coupling choices are DC, AC, AC LF Reject, AC HF Reject, and Noise Reject.</td>
</tr>
<tr>
<td>Video</td>
<td>Single level</td>
<td>None</td>
<td>Trigger on NTSC, PAL, SECAM, Analog HDTV, and Custom video formats.</td>
</tr>
<tr>
<td>Glitch</td>
<td>Single level</td>
<td>One to specify glitch width</td>
<td>Trigger on glitches narrower than the specified width or ignore glitches narrower than the specified width.</td>
</tr>
<tr>
<td>Width</td>
<td>Single level</td>
<td>Two to specify minimum and maximum pulse widths</td>
<td>Trigger on pulses that have widths between the range of the two timers or outside the range of the two timers.</td>
</tr>
<tr>
<td>Runt</td>
<td>Two levels to define the logic transition region</td>
<td>One to specify an optional minimum runt-pulse duration</td>
<td>Trigger on a pulse that enters the transition region from one side but does not leave the region from the other side. Pulses can be qualified with the logical states of other channels (4-channel models only).</td>
</tr>
<tr>
<td>Window</td>
<td>Two levels to define signal transition region</td>
<td>One to specify an optional minimum violation width</td>
<td>Trigger when a signal violates either upper or lower boundaries set outside the normal range of the signal. Events can be qualified with the logical states of other channels (4-channel models only).</td>
</tr>
<tr>
<td>Timeout</td>
<td>Single level</td>
<td>One to specify time-out time</td>
<td>Trigger when a signal does not make a transition for a specified length of time.</td>
</tr>
<tr>
<td>Transition</td>
<td>Two levels to define the logic transition region</td>
<td>One to specify transition time</td>
<td>Trigger when a logic signal spends more time or less time in the transition region than a specified amount of time.</td>
</tr>
<tr>
<td>Setup/Hold</td>
<td>Independent levels for Data and Clock</td>
<td>One to specify setup time and one to specify hold time</td>
<td>Trigger on violations of setup or hold time between a Data signal and a Clock signal. The specified setup and hold times can be positive or negative values.</td>
</tr>
<tr>
<td>Pattern</td>
<td>Independent levels for each channel</td>
<td>One to specify pattern duration</td>
<td>Trigger when a Boolean combination of up to four channels becomes true. Trigger immediately or only after the combination is true for a specified time duration.</td>
</tr>
<tr>
<td>State</td>
<td>Independent levels for each channel</td>
<td>None</td>
<td>Trigger on transition of one channel when a Boolean combination of up to three other channels is true.</td>
</tr>
</tbody>
</table>
To Use A (Main) and B (Delayed) Triggers

You can use the A Event (Main) trigger alone or combine it with the B Event (Delayed) trigger to capture more complex signals.

1. Set the A trigger type and source in the A Event (Main) tab of the trigger control window.

2. Choose a function in the A→B Sequence tab of the trigger control window.

3. Set the trigger delay time or the number of B events, as appropriate.

4. Set the B trigger characteristics in the B Event (Delayed) tab of the trigger control window.

**Trigger on B Event**

The A trigger arms the oscilloscope. Posttrigger acquisition starts on nth B event.

**B Trigger After Delay Time**

The A trigger arms the oscilloscope. Posttrigger acquisition starts on the first B edge after the trigger delay time.

**More Operating Tips:**

- B-trigger delay time and horizontal delay time are independent functions. When you establish a trigger condition using either the A trigger alone or the A and B triggers together, you can also use horizontal delay to delay the acquisition by an additional amount.

- When using the B trigger, the A trigger can be any of the following types: Edge, Glitch, or Width. The B trigger type is always Edge type.
To Take Measurements with Cursors

1. Push the front-panel CURSORS button.

2. Select the waveform you want to measure and a cursor type in the cursor control window. Or you can activate cursors on the selected waveform directly in the Cursor menu.

3. Place cursors with the multipurpose knobs or enter the cursor locations numerically.

4. If you choose split cursors to take measurements between waveforms, select the source for each cursor.

5. Read cursor measurement results in the display.

Other Cursor Measurement Tips:

- You can set the cursors to move together in tandem if you choose the Tracking cursor mode. The cursors move independently if you choose the Independent cursor mode.

- If you use the zoom graticule, you can place a cursor directly on a specific waveform point to take precision measurements.

- You can also move cursors by dragging them to a new position.
To Take Automated Measurements

Click the Meas button, and then select up to eight measurements using the measurement control window.

Use the tabs to access measurements in four different categories.

Or choose a measurement for the selected waveform directly in the Measure menu.

Automated Measurement Selections

<table>
<thead>
<tr>
<th>Amplitude</th>
<th>Time</th>
<th>More</th>
<th>Histogram (Option 2A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Period</td>
<td>Burst Width</td>
<td>Max</td>
</tr>
<tr>
<td>Mean</td>
<td>Rise Time</td>
<td>Wfm Count</td>
<td>Std Deviation</td>
</tr>
<tr>
<td>Positive Overshoot</td>
<td>Phase</td>
<td>Hits in Box</td>
<td>Min</td>
</tr>
<tr>
<td>Low</td>
<td>Frequency</td>
<td>Peak Hits</td>
<td>μ ± 1σ</td>
</tr>
<tr>
<td>Pk–Pk</td>
<td>Fall Time</td>
<td>Pk–Pk</td>
<td>μ ± 2σ</td>
</tr>
<tr>
<td>Negative Overshoot</td>
<td>Positive Duty Cycle</td>
<td>Positive Duty Cycle</td>
<td>μ ± 3σ</td>
</tr>
<tr>
<td>Max</td>
<td>Positive Width</td>
<td>Negative Width</td>
<td></td>
</tr>
<tr>
<td>Amplitude</td>
<td>Negative Width</td>
<td>Negative Duty Cycle</td>
<td></td>
</tr>
<tr>
<td>Min</td>
<td>Cycle Mean</td>
<td>Cycle Area</td>
<td>Median</td>
</tr>
<tr>
<td>Cycle RMS</td>
<td></td>
<td></td>
<td>Mean</td>
</tr>
</tbody>
</table>

Use the tabs to access measurements in four different categories.
To Customize an Automated Measurement

Use Gating to confine the measurement to a certain portion of the waveform.

Turn on measurement statistics to characterize the stability of the measurement.

Adjust the measurement reference levels to different relative or different fixed values.

Select snapshot to see a one-time view of all valid measurements.

To Set Up a Histogram (Option 2A)

Drag across the segment of the waveform that you want the histogram to cover. To set up a horizontal histogram, for example, make the box wider than it is tall.

Select Histogram from the drop-down list.

View the histogram at the top or edge of the graticule.

If you need to make any adjustments to the histogram, use the histogram setup control window.

Take automated measurements on histogram data. See previous page for information.
To Use Standard Math Waveforms

Select **Math Setup** in the **Math** menu.

Choose the math equation that you want to define. (In this example, it is Math 1.)

Select a waveform, an operator, and a waveform to build your waveform expression. In this example, Math 1 is defined as Channel 1 minus Channel 2.

Use the **Apply** button to create the math waveform after defining your math expression.

Use the **Source**, **Scale**, and **Window Type FFT** functions to analyze the frequency components of your signal.
To Use Advanced Math Waveforms (Option 2A)

1. Select **Math Setup** in the **Math** menu.

2. Choose a predefined math expression.

Or click **Editor** to define a more advanced math waveform. Then build the waveform expression using sources, operators, constants, measurements, and functions.

To Use Spectral Analysis

Choose **Spectral Analysis** to define FFT magnitude and phase waveforms. When an FFT waveform is selected, you can use the multipurpose knobs to adjust the FFT waveform just as you would on a spectrum analyzer.

You can view time-domain and frequency-domain waveforms simultaneously. You can also use gating to select only a portion of the time-domain waveform for spectral analysis.
To Save and Recall Waveforms

To save or recall waveforms, select **Reference Waveforms** and then **Save Wfm...** or **Recall Wfm...** in the **File** menu.

Or click the **Refs** button.

Use the reference setup control window to copy a live waveform into one of four nonvolatile reference waveform storage locations. You can also display these waveforms as reference waveforms.

Select **Save Wfm to File** to store the live waveform as a file on a disk drive. You can recall a waveform stored on disk into one of the internal reference waveform locations for display.

To Save and Recall Instrument Setups

To save an instrument setup, select **Instrument Setup** in the **File** menu.

Or click the **Setups** button.

Use the settings control window to save the current setup into one of ten internal storage locations. Use the pop-up keyboard to label the setups for easy identification.

Or select **Save Settings to File** to store the current setup on a disk drive. You can recall any setup stored on disk and then save it in an internal setup storage location for faster access.

To restore the oscilloscope to a known initial state, push the front-panel **DEFAULT SETUP** button.

Or select **Recall Default Setup** in the **File** menu.
To Print a Hard Copy

To print a hard copy to the internal printer, an attached printer, or a network printer, push the front-panel PRINT button or select Print in the File menu.

If necessary, you can make changes to the page orientation in the Page Setup dialog box. Choose Screen-copy to print basic screenshots or Banner to print long, continuous-feed waveforms.

The Page Setup dialog box also includes selectors for the print palette and a feature called Ink Saver. Ink Saver optimizes the display colors and shades for printing hard copies on white paper.

To Export Your Results

You can use the Windows clipboard to copy information. Simply select the item to copy, copy it, and then paste it into another Windows application.

You can export waveform data into a comma-separated ASCII file for use in a spreadsheet or data analysis program. Select Export Setup in the File menu to set the output content and format for images, waveforms, or measurements.
To Run Application Software

You can install and run optional application software on your oscilloscope. These software packages provide advanced capability supporting many applications. Two examples are shown below; additional packages may be available. Contact your Tektronix representative for more information.

Use **TDSJIT2** Jitter Analysis Software to characterize timing performance. Analyze jitter on contiguous clock cycles using single-shot acquisitions.

Use **TDSDDM2** Disk Drive Measurement Software to measure disk drive signals according to IDEMA standards.

Follow the instructions provided with the application software to install it. To run the software, select the application in the **File / Run Application** menu.
To Connect to a Network

Like any other Windows computer, you can connect the oscilloscope to a network to enable printing, file sharing, internet access, and other communications functions.

To make a network connection, consult with your network administrator, and then use the standard Windows utilities to configure the oscilloscope for compatibility with your network.

To Use a Dual Monitor

Connect a keyboard, mouse, and monitor to the oscilloscope and configure Windows for dual-monitor mode. You can operate the oscilloscope while having full use of Windows and other installed applications on the external monitor.

Connect the monitor to the upper SVGA port on the oscilloscope side panel. Use the Settings tab in the Windows Display Properties dialog box to set up a dual-monitor configuration.
To Access the Help System

Click the HELP button or select Help on Window in the Help menu to receive context-sensitive help on the current setup.

Select Contents and Index in the Help menu to access any topic in the help system. Select the topic, and then click the Display button in the dialog box.

Click an outlined control shown in the help window to receive more specific information about the control.

Click a tab in a help window to navigate between the Overview and specific topics.

Click the Minimize button in a help window to move help out of the way so you can operate the oscilloscope. Click the Restore Help button to see the last help topic again.
To Use the Oscilloscope I/O

On the Front Panel

Probe compensator output to compensate and deskew probes.

Auxiliary input

Channel inputs

Floppy disk drive

CD-ROM drive on the side of the oscilloscope; press the button on the cover to open the drive

Ground terminal

On the Left Side Panel

USB connector for mouse, keyboard, or other peripherals

PS-2 connectors for mouse and keyboard

Upper SVGA port to connect a monitor for dual-monitor operation

Lower VGA port to replicate the oscilloscope display on an external monitor

Parallel port (Centronics) to connect printer or other device

GPIB port to connect to controller

RJ-45 connector to connect to network

COM1 serial port

Miniature phone jacks for microphone input and line input and output

Game controller port

On the Rear Panel

External reference input

Trigger signal output

CH 3 signal output (4-channel models only)